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Learning Objectives

By the end of this presentation, you will be able to:

 Understand the basic physics of SAR interferometry

* Describe what SAR interferometric phase tells about the land surface
» Describe the necessary data processing for making an interferogram
 Understand the information content in SAR interferometric images
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Prerequisites

» Basics of Synthetic Aperture Radar 2017
* SAR Processing and Data Analysis 2017
* Introduction to SAR Interferometry 2017
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SAR Interferometry Theory

* Quick review of synthetic aperture radar interferometry theory
« See the 2017 ARSET training “Introduction to SAR Interferometry” for more details
* In SAR interferometry, it is all about the phase of the SAR signal
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SAR Phase — A Measure of the Range and Surface Complexity

The phase of the radar signal is the number of cycles of
oscillation that the wave executes between the radar
and the surface and back again

Number of Cycles
_~ (actually millions!)

0
1

The total phase is a two-way range measured in wave
cycles + random components from the surface

Collection of random path lengths jumbles the phase
/ of the echo

Slide Courtesy of Paul Rosen (JPL)
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A Simplistic View of SAR Phases

41
Phase of mage 1l ¢ = - P + other constants + ny

4m
Phase of Image 2 $2 = - p2 + other constants + n,

1. The “other constants” cannot be directly determined

2. “Other constants” depends on scatterer distribution in the resolution cell, which is
unknown and varies from cell to cell

3. The only way of observing the range change is through interferometry
(cancellation of “other constants”)

Slide modified from Paul Rosen (JPL)
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SAR Interferometry Applications

« Mapping/Cartography
— SAR interferometry was used for the 2000 Shuttle Radar Topography Mission (SRTM), new
2018 release as NASADEM
— Radar Interferometry from airborne platforms is routinely used to produce topographic
mayps as digital elevation models (DEMS)
« 2-5 meter circular position accuracy
 5-10 m post spacing and resolution
* 10 km by 80 km DEMSs produced in 1 hr on a mini-supercomputer

 NASA SAR topography presently acquired by GLISTIN
— Radar imagery is automatically geocoded, becoming easily combined with other
(multispectral) data sets
— Applications of topography enabled by interferometric rapid mapping
« Land use management, classification, hazard assessment, intelligence, urban
planning, short and long time scale geology, hydrology

Slide Modified from Paul Rosen (JPL)
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SAR Interferometry Applications

 Deformation Mapping and Change Detection

— Repeat Pass Radar Interferometry from spaceborne platforms is routinely used to
produce topographic change maps as digital displacement models (DDMs).

* 0.1-1 centimeter relative displacement accuracy
* 10-100 m post spacing and resolution
* 10-350 km wide DDMs produced rapidly once data is available
— Applications include
 Earthquake and volcano monitoring and modeling, landslides and subsidence
» Glacier and ice sheet dynamics
» Deforestation, change detection, disaster monitoring

NASA’s Applied Remote Sensing Training Program 9



Differential Interferometry

 When two observations are made from the same location in space but at different
times, the interferometric phase is proportional to any change in the range of a
surface feature directly.

47 4
r ?;? Ag = 7(p(t1)_ AL,)) = TApchange

Slide modified from Paul Rosen (JPL)
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Differential Interferometry Sensitivities

* The reason differential interferometry can detect milimeter-level surface deformation is
that the differential phase is much more sensitive to displacements than to topography.
d¢  2mpbcos(f —a)  2mpby

Topographic Sensitivity

oh Ap sin 6 ~ Apsinf
0p _ 4m . -
(¢ < Ag) Ap N Displacement Sensitivity

O 4t by . .

Odtopo — 8—th = psinﬁah Topographic Sensitivity Term
% dm | o

Odbaisp — mﬁap = %4 Displacement Sensitivity Term

since 0 << 1 ==> oaisp -, T duopo
p OAp Oh

Meter Scale Topography Measurement - Millimeter Scale Topographic Change

Slide modified from Paul Rosen (JPL)
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Phase Unwrapping

 From the measured, wrapped phase, unwrap the phase from some arbitrary
starting location, then determine the proper 2p phase “ambiguity”

2 -
APrpo = 7@(/01 -p,) =" "be

AQ, s = mod(A(/)mpo,Zn)

' A unwrap( ’ ) = A topo( ’ ) + A const
= Dunsrap (5:P) = A, (5.0) + AP
A¢meas
T / 4 )
. _— vl

A ¢const
A ¢t0p0

Slide modified from Paul Rosen (JPL)

NASA’s Applied Remote Sensing Training Program



Correlation* Theory

* INSAR signals decorrelate (become incoherent) due to
— Thermal and Processor Noise
— Differential Geometric and Volumetric Scattering
— Rotation of Viewing Geometry
— Random Motions Over Time

 Decorrelation relates to the local phase standard deviation of the interferogram
phase
— Affects height and displacement accuracy

— Affects ability to unwrap phase

**Correlation” and “Coherence” are often used synonymously

Slide modified from Paul Rosen (JPL) /SN
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INSAR Correlation Components

« Correlation effects multiply, unlike phase effects that add

 Low coherence or decorrelation for any reason causes loss of information in that
area

Y= Yv YQ YiYe
where

Y, IS volumetric (trees)

Y4 IS geometric (steep slopes)
Y, Is temporal (gradual changes)
Y. Is sudden changes
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Wavelength: A Measure of Surface Scale

Light interacts most strongly with objects
around the size of the wavelength

N W
Forest: Leaves reflect X-band \m mn
wavelengths but not L-band M
\\ \\

\\\ AR LN \\\\\\\\\

A ALY

Dry Soils: Surface looks rough
to X-band but not L-band

lce: Surface and layering look
rough to X-band but not L-
band

Slide modified from Paul Rosen (JPL)
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Coherent Change Detection
SIR-C L and C-band Interferometry

 6-month time separated observations to form interferograms
e Simultaneous C and L band

C-Band A =5.6cm L-Band A =24 cm

_-— -

20 km

C-Band A =5.6cm L-Band A =24 cm NDVI

0 Correlation 1

1 Cycle of Interferometric Phase 20 km Il
) 1 Vegetation 0

INSAR experiments have shown good correlation at L-band

NASA’s Applied Remote Sensing Training Program




O
e
Q
N
Q
'
©
]
O
L
+
©
LL]

IONS—

t

iICa

INSAR Appl




Some Examples of Deformation

Etna Volcano

DISPLACEMENT {cm)

. TIMELINEN

"/ DISPLACEMENT (¢m)

TIMELINE (MO

0 og a8 | 12

Ground subsidence near Pomona, California
Time interval: 20 Oct 93 - 22 Dec 95
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TIMELINE (M(

__ _ 0 & 8L 12
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'\

0. 4 8 V12,018 "20. 24

DISPLACEMENT (cm)
(edW) IHNSSTMA

Joughin et al , 1999

ERS-1, 3-pass interferogram

Slide modified from Paul Rosen (JPL) G. Poltzer, 1997 - JPL
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Asal Rift Dike Injection

Envisat interferogram 6 May — 28 Oct
2005; form Tim Wright, U. Leeds
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2015 M7.8 Gorkha Earthquake in Nepal

ALOS-2 ScanSAR interferogram

Descending line-of-sight (LOS) perpendicular
to horizontal

INSAR phase only sees vertical component

High Himalayas dropped down as much as
1.2 m

Yue, H., et al. (2017), Depth varying rupture
properties during the 2015 Mw 7.8 Gorkha
(Nepal) earthquake, Tectonophysics, v. 714-
715, p. 44-54, doi:10.1016/j.tecto.2016.07.005.

GPS data from Galetzka, J., et al. (2015), Science, 349 (6252), 1091-1095
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Creep on the San Andreas Fault

iv2

37.0

latitude

Figures from Isabelle Ryder, UC Berkeley
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Decorrelation Shows Surface Ruptures

2003 M6.5 Bam
earthquake in Iran

1.0
0.8
0.6
0.4
0.2

EIER] 200 Fen v 152904

Envisat 35 days
2003/12/3 -
2004/1/7
Descending track

Bperp 580 m

Fielding, E. J., M. Talebian, P. A. Rosen, H. Nazari, J. A. Jackson, M. Ghorashi, and R. Walker (2005), Surface ruptures and building damage of the 2003 Bam, Iran, earthquake mapped by satellite synthetic aperture radar interferometric

correlation, J. Geophys. Res., 110(B3), B03302, doi:10.1029/2004JB003299.
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Correlation change

B =00 Fea 22 30032 EdF
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Envisat co-seismic
correlation minus pre-
seismic correlation

red is co-seismic
decorrelation




Landslide Motion

ht Lines
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Combination of Four NASA UAVSAR InSAR Flig

24

Delbridge, B. G., R. Birgmann, E. Fielding, S. Hensley, and W. H. Schulz (2016), Three-dimensional surface deformation derived from airborne interferometric UAVSAR: Application to the Slumgullion Landslide, J. Geophys. Res. Solid Earth,

121(5), 3951--3977, doi:10.1002/2015JB012559.
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SAR satellites i

cycle | length

(days) | (cm)
European ERS-/ERS-2 ‘92-'01(-20 11) 513139 | 6
Canadian Radarsat-11995-2013 24 6
European Envisat 03-Sep.’10(*10-Apr.’12) 35 (30) 6
Japanese ALOS Jan. 2006-Apr. 2011 46 24
German TerraSAR-X 07, TanDEM-X ‘10 1 3
| talilan COSMO-SkyMed 4x launch 07-710 16 (1,4,7,8) 3
Canadian Radarsat-2 launched Dec. 2007 24 QA




new SAR spacecraft

repeat | wave-

satellite (launch or planned) cycle | length

(days) | (cm)
European Sentinel-1 (A: Apr. 2014, B: May 2015) 12(6) 0
Japanese ALOS-2 (May 2014) 14 24
Indian RISAT-1(Apr. 2012) 25 6

N ASA-ISRO SAR (N ISAR) mission (2021) 12 12,24




NASA-ISRO SAR Mission (NISAR)

High spatial resolution with frequent
revisit time

Earliest baseline launch date: 2021

Dual frequency L- and S-band SAR

— L-band SAR from NASA and S-band
SAR from ISRO

3 years science operations (5+ years
consumables)

All science data will be made
available free and open

https://nisar.jpl.nasa.qov

Slide Courtesy of Paul Rosen (JPL)
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NISAR Characteristic:
L-band (24 cm wavelength)

S-band (12 cm wavelength)

SweepSAR technique with
Imaging Swath >240 km

Polarimetry
(Single/Dual/Quad)

12-day exact repeat

3-10 meters mode-dependent
SAR resolution

3 years since operations (5
years consumables)

Pointing control < 273
arcseconds

Orbit control < 500 meters
>30% observation duty cycle
Left/Right pointing capability

Noise Equivalent Sigma Zero <
-23db

Would Enable:

Low temporal decorrelation and
foliage penetration

Sensitivity to light vegetation

Global data collection

Surface characterization and
biomass estimation

Rapid Sampling

Small-scale observations

Time-series analysis

Deformation interferometry

Deformation interferometry
Complete land/ice coverage
Polar coverage, North and South

Surface characterization of
smooth surfaces



https://nisar.jpl.nasa.gov/
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How to Get Data for INSAR

C & Secure https://www.asf.alaska.edu/sar-data/insar/ AN BP9 30eceB8 4P
Apps [] NBS Login ¥ Linksys Setup [} Save to Mendeley @ jfleck at inkstain |... [l SSARA search GUI [} ADSL Modem [) Capture Reference [ Oklahoma quakes... » [ Other Bookmark

U ALASKA SATELLITE FACILITY — e R/

Meaking remote-sensing data accessible since 1991

Get Started Get Data Datasets Data Tools About SAR About ASF

" # [SAR Datasers / InSAR

Sentinel-1 InSAR =18 —I!H’! 114

SMAP

Seasat
Wetlands MEaSUREs About InSAR

Sea lce MEaSUREs
Differential interferometric synthetic aperture radar (InSAR) is used to measure
Terrestrial Ecology displacements on Earth’s surfaceRo a precision of a few centimeters or less. InSAR data
are largely used to study deformation caused by earthquakes, volcanic eruptions,
Coverage Map - Legacy glacier movements, landslides, and subsidence. They may alsc be used to examine the
distribution of water vapor in the atmosphere, among other applications. For examples

: 1
Find Data of InSAR applications, click on slide show at right.
Product Guide - Legacy
Collaborations Sentinel-1 InSAR BETA PrOdUCt.S Deformation resulting from 2008 Nevadg
ALOS PALSAR earthquake. Image courtesy of Charles
Find Sentinel-1 InSAR Data | Wicks, USGS, © CSA
RADARSAT-1 : p
ERS-1 GRFN (Get Ready for NISAR) BETA products are prototype Level 2 interferometric
ERS-2 products created by the Science Data System under development for the NISAR
ERS-1 mission. The creation, discovery, and distribution of these products Is to inform the
s NISAR mission team of possible cloud-based processing and data-management
UAVSAR solutions. As such, these prototype products are not part of the ASF long-term archive,
AIRSAR and may become unavailable at any time as new SAR interferometric processing and

delivery methods are explored.

Collections
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Southern Mexico Earthquakes 2017-2018

We will look
at the 16
February
2018 Mw 7.2
earthquake
near
Pinotepa in
Oaxaca

4000
3000
2000
1000
sea level
1000
—2000
=3000
—4000

elevation
(meters)

SRTM30
Plus
(Becker et al,
2009)
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Accessing Sentinel-1 Data for Interferometry

1. Go to the Alaska Satellite Facility Sentinel Data Portal:
https.//vertex.daac.asf.alaska.edu/

2. |ldentify the area (-99,16,-99,15,-97,15,-97,16,-99,16) and dates (2018-02-05, 2018-
02-17) of interest (M7.2 Pinotepa earthquake in Oaxaca, Mexico)

3. Identify images of interest (Sentinel-1 A/B)
4. Select path 5
5
6

. Click Search

. Select Granule;:
S1B IW_RAW_ 0SDV _20180205T003836 20180205T003909 009481 0110EO _FEAF
(Frame 49)

7. Download the L1 Single Look Complex (SLC) (4.76 GB) Product

8. Similarly download SLC for Granule:
S1B IW_RAW __0SDV_20180217T003836 20180217T003908 009656 0116A5 3F00
(Frame 49)

NASA’s Applied Remote Sensing Training Program


https://vertex.daac.asf.alaska.edu/

Accessing Sentinel-1 Data for Interferometry

Dataset: Sentinel-1B
Granule: S1B_IW_RAW_0SDV 20180205T003836 20180205T003909 009481 0110E0_FEAF

Granule Details

» Acquisition Date: 2018-02-05

« Beam mode: IW

« Path: 5

« Frame: 49

» Ascending/Descending: Ascending
« Polarization: VW+VH

« Absolute Orbit: 9481

» Frequency: C-Band

Products Download

L1 Detected High-Res Dual-Pol (GRD-HD) =+ Queue
(1.07 GB) X Download

L2 Ocean (OCN) (5.57 MB) =+ Queue

& Download

L1 Single Look Complex (SLC) (4.76 GB) + Queue
¥ Download Full Resolution Browse Image

NASA’s Applied Remote Sensing Training Program




Opening the Data with the Sentinel Toolbox

We use the same Toolbox as for SAR amplitude analysis
* Initiate the Sentinel Toolbox (SNAP) by clicking on its desktop icon
* In the Sentinel Toolbox interface, go to the File menu and select Open Product

» Select the folder containing your Sentinel-1 SLC file, and double click on the .zip file
(do not unzip the file; the program will do it for you)

NASA’s Applied Remote Sensing Training Program



Opening the Data with the Sentinel Toolbox
SLC Data Has a Different Format Than GRDH

1. The Product Explorer window of the Sentinel Toolbox
contains your file. Double click on the file to view the
directories within the file, which contain information
relevant to the image, including:

— Metadata: parameters related to orbit and data

— Tie Point Grids: interpolation of latitude/longitude,
iIncidence angle, etc.

— Quicklooks: viewable image of whole scene in
radar coordinates

— Bands: complex values for each subswath “i” and
“g” and intensity (intensity is the amplitude squared,
a virtual band)

NASA’s Applied Remote Sensing Training Program

Product Explorer £ Pixel Info
v = [1] SIB_W_SLC_ 15DV_20180205T003836_20180205T003906_009481_0110E0_6407
» [ Metadata
» [ Vector Data
» 3 Tie-Point Grids
¥ 3 Quicklooks
.

» [ eands

Navigation - [7] P... |Colour Manipulatio... | Uncertainty Visuali... | ‘World View Quicklool ks £ -|:

(1] S1B_IW_SLC__1SDV_20180205T003836_20180205T003906_009481_0110E0_6407 Quicklook




Opening the Data with the Sentinel Toolbox

Viewing Subswath Images

nnnnnnnnnnnnnnn

2. The Worldview image (lower left)
shows the footprint of the whole
Image selected

3. Select intensity image for swath IW1
\AY/

— Note: Each SAR image is flipped
north—south because it is oriented
the same way it was acquired
(ascending track in this case)
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INSAR Processing




Interferometry Data Preparation
Coregistering the Scenes

1. The first step of interferometry is to coregister T B T PO
tWO SLC |mages Source Product

Name:
[2] S1B_IW_SLC__1SDV_20180217T003836_20180217T003906_009656_0116A5... ¢

2. From the top main menu bar, select Radar,
then Coregistration, then S1 TOPS
Coregistration, and then S1 TOPS

Data Format: Any Format £

Read Read(2) TOPSAR-Split(2) Apply-Orbit-File >

Coregistration again T
— In the Read tab, select the 20180205 SLC B
and in the Read(2) tab select the 20180217 - =
SLC

— In TOPSAR-Split and TOPSAR-Split(2) tals,
select Subswath: IW1 Polarisations: VV

— In the Write tab, select the directory where
you want to save your processing results
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Interferometric Processing
Forming a Raw Interferogram

1. Second step of interferometry is to make
an interferogram out of the coregistered
SLC images

2. From the top main menu bar, select
Radar, then Interferometric, then
Products, and then Interferogram
Formation

— In I/O Parameters tab, select the
“Orb_Stack” product created by the
coregistration step

— By default, the output target is in same
directory and adds “ifg” to the name

— For basic processing, no need to
change defaults in Processing
Parameters tab

NASA’s Applied Remote Sensing Training Program

File Help

Processing Parameters

Source Product
Source product:
[2] S1B_IW_SLC__1SDV_20180205T003836_20180205T003906_009... ¢

Target Product
Name:

_ 20180205T003836_20180205T003906_009481_0110E0_6407_0Orb_Stack_ifg

V| Save as: BEAM-DIMAP C
Directory:
g/nobak /Mexico/Pinotepa2018/S1lproc/S1/project/Processed Products | ...

v Open in SNAP

Run Close




Interferometric Processing
Viewing a Raw Interferogram — Phase Image

v = [3] S1B_Iw_SLC_1SDV _20180205T003836_20180205T003906_009481 0110E0_6407_Orb_Stack_ifg
» [ Metadata
» (2 Vector Data
» (22 Tie-Point Grids
v &3 Bands
[ i_ifg_IW1_VV_05Feb2018_17Feb2018
E q_ifg_IW1 VV_05Feb2018_17Feb2018
] Intensity_ifg_IW1_VV_05Feb2018_17Feb2018
E Phase_ifg IW1_VV_05Feb2018 17Feb2018
i coh_IW1_VV_05Feb2018_17Feb2018
Colour Manipulation - [3... | Uncertainty Visualisation World View [ Quicklooks h

Navigation - [3] Phase_if...
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Interferometric Processing
TOPS Debursting and Topographic Phase Removal

1. Nextstep of interferometry with Sentinel-1 3. Next step for all interferometry is to remove

TOPS mode (IWS) data is “debursting” or the topographic phase using a DEM.
combining the bursts. This is not 4. From the top main menu bar, select
necessary with Sentinel-1 or other Radar, then Interferometric, then
stripmap SAR data. Products, and then Topographic Phase
_ Removal
2. From the top main menu bar, select — InI/O Parameters tab, select the
Radar, then Sentinel-1 TOPS, and then S-1 “Orb_Stack _ifg_deb” product created
TOPS deburst by the deburst step or “Stack_ifg” if not
— In I/O Parameters tab, select the TOPS mode
“Orb_Stack_ifg” product created by — By default, the output target adds
the interferogram formation step “dinsar” to the name

_ — The Processing Parameters tab shows
By default, the output target adds the default is to download SRTM 3-

“deb” to the name | arcsecond DEM, which is fine for basic
— No need to change Processing processing but you might need
Parameters tab another DEM in some cases

NASA’s Applied Remote Sensing Training Program



Interferometric Processing
Viewing Differential Interferogram — Phase Image

i

v & [5]S1B_IW_SLC_ 1SDV_20180205T003836_20180205T003906_009481_0110E0_6407_Orb_Stack_ifg_deb_dinsar
> Metadata
» (21 Vector Data
» ([C1 Tie-Point Grids
¥ {3 Bands
[ i_ifg_vV_05Feb2018_17Feb2018
B q_ifg VV_05Feb2018_17Feb2018
[ Intensity_ifg_VV_05Feb2018_17Feb2018_ifg_srd_VV_05Feb2018_17Feb2018

B coh w1l vV _05Feb2018_17Feb2018

Quicklooks @

Navigation - [S] Phase_if... | Colour Manipulation.-[s..;..l Uncertainty Visualisation ]
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Interferometric Processing
Filtering and Multi-Looking Interferogram

1.

Two steps can reduce the noise level in
the interferogram, filtering and multi-
looking. We apply filtering first, but you
can also do multi-looking first.

From the top main menu bar, select
Radar, then Interferometric, then Filtering,
and then Goldstein Phase Filtering

In I/0O Parameters tab, select the
“dinsar” product created by the
previous step

By default, the output target adds “flt”
to the name

For basic processing, no need to
change defaults in Processing
Parameters tab

NASA’s Applied Remote Sensing Training Program

3.

Multi-looking is averaging multiple pixels
In each direction, what radar engineers
call "taking multiple looks”. It results in
larger pixels and can greatly reduce the
noise.

The amount of multi-looking you should
do depends on the spatial resolution
you need and the spacing of the
fringes




Interferometric Processing
Multi-Looking Interferogram

1. The Pinotepa earthquake has a depth of

about 25 km, so the fringes are widely Al R

spaced. There is also no surface rupture, so 1/O Parameters

we can do more spatial averaging without . =

losing any earthquake signal. e e,
2. From the top main menu bar, select Radar e o S reb2018 17reb 0.

and then |\/|u|ti|00king coh_IW1_VV_05Feb2018_17Feb2018

— In I/O Parameters tab, select the
“dinsar_flt” product created by the filtering
step and, by default, the output target | || 2 SR Sduare P Independent Looks
addS “ML” tO the name Number of Range Looks: 17

— In Processing Parameters tab, select Source

Number of Azimuth Looks: 5

Bands | Ifgn uq_ifgn, and “COh”: FOI' thlS Mean GR Square Pixel: 70.540596
scene, | use 17 range looks and it Output Intensity |
calculates 5 azimuth looks to give ~70 m Note: Detection for complex data

output pixels
— Don’t choose “Phase” band! Run Close
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Interferometric Processing
Viewing Multi-Looked Interferograms

1. First, we need to make a new virtual
phase band after multi-looking the
complex interferogram

2. From the top main menu bar, select
Raster, then Data Conversion, then
Complex i and g to Phase

3. Now you can display the new phase
band

* The fringes are much less noisy

* Aspect ratio has changed so the pixels
are roughly square on the ground

« New image is now 1207 pixels across,
much smaller than original 20535 pixels

NASA’s Applied Remote Sensing Training Program




Interferometric Processing
Phase Unwrapping

1. SNAP 6.0 does not include phase
unwrapping. It has way to export Read
iInterferogram to unwrap with third-party
program Snaphu (Statistical-cost,

Target folder:

Network-flow Algorithm for Phase e et
Unwrapping) by Chen and Zebker. :'“abm“f:l' . .

2. From the top main menu bar, select Y 67T Gl 1
Radar, then Interferometric, then Nurmber of Processors: :
Unwrapping, and then Snaphu Export. Row Overtap: 0

— In Read tab, select the “ML” product Column Overlap: :
created by the multilooking step Tile Cost Threshold: 500

— In Snaphu Export tab, change the
Statistical-cost mode to “SMOOTH”

— Also change the number of tile rows
and columns and number of processors
to “1” because we don’t need multiple
tiles after multilooking @ D

Error: [Nodeld: SnaphuExport] Please add a target folder
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Interferometric Processing
Phase Unwrapping

1. In Snaphu Export tab, you also need to
specify a target folder for exported files. |
put the Snaphu files in a separate folder
(here called “snaphu_unw”), so you need to
create it either from the selection dialog or

demo

File: snaphu_

unw

<>

in another window. —
2. The Snaphu Export pop-up dialog does not demo_proj

demo_proj.xml

work quite right in SNAP 6.0. Workaround: snaphu_unw

— Navigate to directory that includes the
“snaphu_unw” folder

— The “select” button won’t work to chose
the “snaphu_unw” folder

— Type “snaphu_unw” in the File: box at the
top, then choose Select

3. Now you can press Run button and SNAP File Format:
exports the interferogram phase and
coherence with a “snaphu.conf” file New Folder
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~  Date Modified
Thursday, July 26, 2018 3:04 PM
Thursday, July 26, 2018 3:04 PM
Thursday, July 26, 2018 3:10 PM

All Files c

Cancel Select




Interferometric Processing
Phase Unwrapping

1.

Installing Snaphu: ESA now provides pre-built
binary executables for Linux and Windows 32- or
64-bit systems at http://step.esa.int/main/third-
party-plugins-2/snaphu/.

For Mac or other machines, you need to
download from Stanford and build it yourself
(“make” in “src” usually works).

You also need to add the snaphu/bin directory
to your path.

After the Shaphu Export step in Snap, you have to
run the Snaphu program on the command line:

Navigate to the “snaphu_unw” folder and
open it

You should see folder with name of product
you exported, e.g.

S1B IW SLC 1SDV_20180205T003836 2018
0205T003906_009481 0110EO_6407 Orb_St
ack 1fg deb dinsar_ flt ML17

Move to that folder
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3. You should see the wrapped
interferogram phase “Phase_ifg*.img”,
coherence “coh_*.img”, and a
“snaphu.conf” file.

4. The beginning of the “snaphu.conf” file
shows the command to run Snaphu, e.qg.,

# Command to call snaphu:
#

# snaphu -f snaphu.conf
Phase 1fg_VV _05Feb2018 17Feb2018.sna
phu.img 1207

5. The Snaphu program can take a long
time to run. At the end it writes
unwrapped phase to “Unw_ifg*.img” file



http://step.esa.int/main/third-party-plugins-2/snaphu/

Interferometric Processing
Phase Unwrapping

1. Now, we import the unwrapped phase.
From the top main menu bar, select S
Radar, then Interferometric, then Name:
Unwrapplng and then Snaphu Import [31 S1B_IW_SLC__1SDV_20180205T003836_20180205T003906_009481_0110E0... < | ...

2. The Read-Phase tab should be set to the o
wrapped product that you exported.

3. Inthe Read-Unwrapped-Phase tab, select
the unwrapped source product:

— Navigate to folder where you exported

1-Read-Phase 3-Snaphulmport  4-Write

File: "V_05Feb2018_ 17Feb2018.snhaphu.hdr

S1B_IW_SLC__1SDV_20180... &

Name ~  Date Modified

coh_IW1_VV_05Feb2018_17Feb201... Thursday, July 26, 2018 3:20 PM
coh_IW1_VV_05Feb2018_17Feb201... Thursday, July 26, 2018 3:20 PM
Phase_ifg_VV_05Feb2018_17Feb20... Thursday, July 26, 2018 3:20 PM
Phase_ifg_VV_05Feb2018_17Feb20... Thursday, July 26, 2018 3:20 PM

LR TR R

for Snaph U snaphu.conf Thursday, July 26, 2018 3:20 PM
snaphu.log Thursday, July 26, 2018 3:25 PM
— Select the % UnwPhase_ifg_VV_05Feb2018_17Fe... Thursday, July 26, 2018 3:20 PM
- . & UnwPhase_ifg_VV_05Feb2018 17Fe... Thursday, July 26, 2018 3:28 PM
“UnwPhase_ifg*.snaphu.hdr” file N ’ e B
4. Go to Write tab and check product RS .

output name (I add ”_unw” to wrapped
product name, so | get a new product) New Folder Cancel J  Select
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Interferometric Processing
Phase Unwrapping

v @ 4l S1B_W_SLC__15DV_20180205T003836_20180205T003906_009481_0110E0_6407_Orb_Stack_ifg_deb | ';-
» O3 Memadata Y,

1. Finally, we can now display the Bt

unwrapped phase

— Select the Unw_Phase ifg band Bm——
— Go to the Colour Manipulation tab
and select “100%” to stretch color

scale to full range of unwrapped =
data SO D

— Unwrapped phase is still in radians

— Phase is reference image minus
coregistered image. If reference
Image is earlier, then negative
phase is land moving toward
satellite (hegative range change)

i
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Interferometric Processing
Phase to Displacement

1. We can convert the unwrapped phase to
displacements. From the top main menu
bar, select Radar, then Interferometric,
then Products, and then Phase to
Displacement.

— The I/0 Parameters tab should be set to
the unwrapped product that you
imported.

— default for target product name is to
add “ _dsp” to the name
2. Now, we can display displacement band
of result. Again, better to stretch colors.
— Displacements now in meters.

— Sign was changed so positive
displacementis “up” towards satellite
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@ [2] 51BIW_SLC_15DV_20180205T003836_20180205T003906_009481_0110E0_6407
» 1 Metadata
» [ Vector Dara
» 2 Tie-Point Grids
v & Bands

. displacement




Interferometric Processing
Geocoding results—Terrain Correction

b I [3] 51B_W_SLC__150V_20180205T003836_20180205T003906_009481 011 050_5401T

1. SNAP calls geocoding with topography “Terrain [
Correction.” From the top main menu bar, select =
Radar, then Geometric, then Terrain Correction,
and then Range-Doppler Terrain Correction.

— The I/0O Parameters tab should be set to the
displacement product that you imported (or
one of the other ML products).

— default for target product name is to add
“ TC” to the name

— Under Processing Parameters tab, select the Lﬂ_l
Source Bands and any additional Output T TS
Bands. You can also choose what DEM to use, Name dstacamer |
output spacing, and map projection. '=

2. Now, we can display displacement_vv band of
geocoded result. Again, better to stretch colors.

— Displacements in meters with positive values
‘up” towards satellite in Line-of-Sight direction.

— Productis now evenly spaced in latitude and
longitude.

bl L b, il

e
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Earthquake Displacement Analysis
Displacement Profiles

Profile Plot for displacement_VV

1. Use the line drawing tool (top bar of SNAP
window) to draw a line across the signal.

2. Run Analysis>Profile Tool to see
displacement along the profile

displacement_VV in meters
e o o o e o o

3. Remember that INSAR displacements are L L
relative

— In this case, displacement far from the
signhal is about -0.1 m, so that is probably
the “true zero” offset

— Maximum is about 0.24 m, but we need
to subtract zero offset to get total
displacement of about 0.35 m
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Earthquake Displacement Analysis
Unwrapping Errors

4. Zoom in to the main signal.

5. Notice the sharp discontinuities in the
displacement near the coast in my
interferogram (yours may be different):

— Pin 1 in the figure points to the largest
discontinuity

— Go back and look at fringes of the
wrapped interferogram

— Wrapped interferogram has noise at
that location but phase looks
continuous, so this is likely a phase
unwrapping error

— You may need to adjust filtering and
multilooking to get better unwrapping
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Earthquake Displacement Analysis
Exporting Displacement Map

1. For more analysis, you may want to
use Matlab, QGIS, ArcGIS or other
analysis tools. QGIS is great free and
open source tool (https://qQqis.org).

2. You can export the geocoded
displacement map with the
File>Export function

3. For GIS analysis, the GeoTIFF format
usually works well

4. In QGIS, can use "Add Raster Layer”
to read the GeOTIFF file.
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https://qgis.org/

Earthquake Displacement Analysis
Comparing to Other Data
1. In QGIS, can modify the color scale,

load other information from various T 10
sources

2. Can also add annotation like scale
bars, labels, and legends in QGIS 10500
Print Composer

—m 16.500

Legend

3. Here, | added epicenters from two @ vsosreommane ST L
sources (USGS preliminary and SSN K s
Mexico preliminary) and contours on ~ mae
depth of the subducting slab from =ow - A
Slab1.0 database (Hayes et al., 2012) — =
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Earthquake Displacement Analysis
Merging Subswaths

1. For this earthquake, most of the

displacement is in the IW1 subswath that InSAR Graphs °
we processed from this track Name ~ Date Modified

. BandSelect-Coreg-Interferogram-Filter.xml Monday, May 21, 2018 9:08 PM
2- For more com plete analyS|S, we ShOUId Deformation-Pre-Processing-Snaphu.xml Monday, May 21, 2018 9:08 PM
proceSS at |east the adjacent |W2 Deformation-Pre-Processing.xml Monday, May 21, 2018 9:08 PM
DEM-Ceneration-Pre-Processing-Snaphu.xml Monday, May 21, 2018 9:08 PM
Su bswath and then use TOPSAR Merge DEM-Generation-Pre-Processing.xml Monday, May 21, 2018 9:08 PM
. . . . TOPSAR Coreg Interferogram IW All Swaths.xml Monday, May 21, 2018 9:08 PM
3- SNAP haS bU||t'|n Graphs or com b|nat|0ns TOPSAR Coreg Interferogram.xml Monday, May 21, 2018 9:08 PM
Of Ste pS |nto a S|ng|e Workﬂow under TOPSAR Slices Coreg Interferogram.xml Monday, May 21, 2018 9:08 PM

Tools>Graph Builder, then Load button.

4. Running Graphs can take huge amount
of memory (much more than running LAl
each step separately), but you can also L S —
use them to see correct order of steps e
(TOPSAR Coreg Interferogram IW All
Swaths.xml shown here)

_TOPSAR-DEbu rst

TOPSAR-Split Back-Geocoding I—)I Interferogram

= TOPSAR-Merge |-
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Earthquake Displacement Analysis
Getting Ready For NISAR

1. Caltech-JPL ARIA and ASF have joint
project called Getting Ready for NISAR i

Dataset: Sentinel-1 Interferogram (BETA)

2 ] SO me sam p | e ke B eta’ 4 Se ntl ne | - 1 Granule: S1-IFG_STITCHED_TN005_20180217T003906-20180205T003836_s123 along-7556-v1.2.1-standard
interferogram products were processed =~ "™

« Acquisition Date: 2018-02-17

by ARIA and stored in ASF Archive - Beam mode: W

3. In our original ASF Vertex search, there e ——
was a GRFN product available that is + Absolute Ort: 9656

« Frequency: C-Band

two slices and all three subswaths
StItC h e d tog eth e r. G ran u | e S 1 - Sentinel-1 All Interferometric Products (BETA) + Queue
IFG_STITCHED TNOO5 20180217T00390 - wsswe 3 Dowriosd
6 — 2 O 1 80 2 05T003 83 6_8 1 2 3_a I O n g — Sentinel-1 Unwrapped Interferogram and = Queue

Coherence Map (BETA) (284.71 MB) * Download

7556-v1.2.1-standard “

Sentinel-1 Full Resolution Wrapped + Queue

Products Download

Interferogram and DEM (BETA) (1.16 MB) * Download

4. Can download Unwrapped IIIII Full Resolution Browse Image
Interferogram and Coherence Map
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Earthquake Displacement Analysis
Getting Ready For NISAR

5. The GRFN Sentinel-1 “Beta” R R T — [P
Interferogram products are in the L s o R o ctereem 0
INSAR Scientific Computing — ko
Environment (ISCE) format o4 meers

6. QGIS can read the “.vrt” file to load ool + v " -
the raster layer

7. Map shown here is full stitched GRFN
unwrapped interferogram converted
to displacement 17000 +- + - 17.000

8. Note many variations far from
earthquake that are likely due to S
water vapor in atmosphere mo!j e it |16,000

T
-99.000 -98.000 -97.000
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Earthquake Displacement Analysis
Earthquake Modeling

1.

Fault slip modeling is an advanced
geophysical topic

One or more interferograms can be used to
estimate slip on fault at depth with inversion
methods

Interferogram is sampled at about 500-1000
points (top)

Then inversion determines slip on fault and
estimates synthetic interferogram (middie)

Difference or residual shows how well slip
model fits data (bottom)
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Earthquake Displacement Analysis
Earthquake Modeling

-99°00' -987°48' -98°36' -98'24' -98712' -98°00' -97°48' -97°36' -97°24' -97°12' -97°0

6. Map view of slip model on fault with

5 by 5 km patches "
7. Fault from Slab database o]
8. Inversion with Caltech fully Bayesian 166" |
slip inversion AlTar (Minson et al., .
2012)
9. Used GPS, three Sentinel-1
interferograms (A005, D143, D070)
and one ALOS-2 interferogram ]
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